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Overview

If you come to Word from a typewriter background, you are probably used to setting up
tabular material using tabs. The very word tab is short for “tabulator,” and “tabulator”
stops on a typewriter are used in “tabulation,” that is, making tables. So your first
impulse when you need to make a table in Word may be to use tabs.

Sometimes this is an acceptable (or occasionally, even the best) way to go. For a simple
table with short entries, and very few rows, setting tab stops can be quick and easy, and
Word allows you to drag them around until the text lines up where you want it. If you do
use tabs to create a “table”, be sure you use them properly; in particular, never use the
built-in tab stops; always create your own. For tips on this subject, see Setting tabs (Or
how to prevent tabbed paragraphs from going all over the place when pasted
between documents).

Like other word processors, however, Word offers a very easy way to create tables that
use true rows and columns, as opposed to simply containing tabular text. Whenever
your needs are less simple — for example, whenever the text in any column of your table
might need to wrap to the next line, or you need vertical table borders, or your table
might span more than one page and need a continuation header, or if you might ever
conceivably need to change the column order — you should use Word’s built-in Table
feature. Note that you can convert tabular text into a Word Table in one step, provided
your tab stops were set properly, by selecting Table | Convert Text to Table and
pressing OK. See also Changing your mind.

Many people who are not familiar with using true Tables try to use text boxes to simulate
the appearance of a table with borders; or sometimes even to draw their borders using
horizontal and vertical drawing lines. As well as making life far more difficult than it need
be during the design of the table, this also creates a maintenance nightmare, should
anyone need ever need to add, delete or amend the data later, or to paste the table into
another document. There is really no circumstance in which using text boxes or drawing
lines to create tabular information is ever preferable to using a table.

Let’s look at what Word's Table feature does.

What is a Table?

How is a Table different from a “table” of tabbed text? As you know, you can arrange
tabular material using tabs. For example, you can use a combination of left-, center-,
decimal-, and right-aligned tab stops, in combination with horizontal paragraph borders,
to create a text-based “table” such as the following (shown with non-printing characters
displayed, so you can see how it was created):
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Natice (in Figure 2) what can happen when you add some text to one of the lines,
because of the lack of support for word-wrapping:
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- 19.09
Figure 2

Selecting a single “column” is possible (hold the Alt key down while you drag with the
mouse); but is much more difficult than if a Word Table had been used; and it is not
possible to have a running header, should the table span two pages.

But suppose the tabular material is more complex. For instance, suppose you have
paragraph text to be placed in side-by-side columns, as in the following example:

Comment, Statement, or Assertion Response or Rebuttal

Mr. Doe accepts the appraisal as It is not adequate for an appraisal to
“conform[ing] in most categoriesto R41b  conform “in most categories.” Thisislike
and the Standards of Professional Practice  saying that adriver generaly follows

in place at the date of the appraisal. traffic laws but will intentionally run ared
light or stop sign.

The report states: “I cannot render an Thisimplies both that Mr. Doe agrees with
opinion asto the accuracy of the the value estimate and that there are or
valuation,” and “there are indications that could be indications that the value
the value indicated in the report is indicated is not reasonable.
reasonable.”

Figure 3

When you use tabs to create such a “table”, each “row” of the table (or sometimes the
whole table) is a single paragraph. If you tried to type text such as the above using tabs
(and | have actually seen this done!), you would have to break the paragraphs up into
fragments that would fit on each line. If the text had to be edited, it would be a
nightmare. But when you use Word’s Table feature to create a table, Word creates a
“cell” for each intersection of a row and column. Each cell contains a separate
paragraph (or can contain several paragraphs); and the text in the cell can wrap
independently of the rest of the table. So whenever your tabular material contains text

that must wrap to the next line a Word table is far more satisfactory than a tabbed table.

Inserting a table

Inserting a table is easy.

If you choose Insert Table from the Table menu (or in Word 97, select Insert from the
Table menu), you can choose the number of rows and columns you want your table to
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start with. (Don't ever select Table | Draw Table, for the reasons discussed below
under Drawing tables.)

Or you can use the context-sensitive Table button on the
Standard toolbar; when you click on this you will see a
flyout table grid on which you can use your mouse to
select the desired number of rows and columns.

Although the flyout (see Figure 5) shows five columns
and four rows when you first click on it, you can drag to
select more rows and columns; the maximum number = ==
depends on your window size, your screen resolution, = Insert Ru:uwsl—
and the relative placement of the button on your toolbar
—that is, how far you can drag before reaching the side
or bottom of the Word window.

P— m—

The number of columns is all that really matters

because you can add rows to the table as you go: Figure 4: The Table button on the
whenever you press Tab at the end of the last row of the Standard toolbar is
table a new row is created. context-sensitive, its appearance

and functionality being
determined by what is selected

mefi = o For this reason | usually just create two
| 2iij = 4 | Q) T ow  ~ rows, one for the table )r/léadings and
: 5 ..... | - & - another for the first row of text. If
— applying grid borders, it's best to start
ER ..... B9 with three rows, so that you can apply

_ one grid to row 1 and a separate grid to
..... rows 2-3; but you would almost never

need to start with more than that.

45 Table a Y-point border around the cells,
Figure 5: The Table button flyout creating a grid.

When you first insert the table, it will have

You can remove this, if desired, by selecting “None” in the Borders and Shading dialog,
or using the Tables and Borders toolbar, or the Borders button on the Formatting
toolbar.

You may also be able to remove the border by pressing Ctrl+Alt+U, although in some
versions and languages of Word, this shortcut inserts a i symbol instead (and there is
no way of preventing this from happening — it seems to be a bug). But if your installation
of Word suffers from this problem, you could get round this by assigning some other
keyboard shortcut to the strangely named command “TableUpdateAutoFormat”, which
removes the borders; and then use your own shortcut when you want to remove the
borders.

In Word 2000 and above, you can also change Word's behaviour, so that when you first
insert a table, it will always be borderless. To do this, select Table | Insert Table; select
the checkbox that says “Set as default for new tables”; then click the AutoFormat
button, de-select every checkbox you see in the AutoFormat dialog; and click OK twice.
From now on, all new tables will be inserted without borders.

Even if you remove the border, you may still see faint lines between the table cells; these
are gridlines; they are just a (very important) visual aid, and do not print. If you do not
see them, select Table | Gridlines to turn their display on. For more on borders and
gridlines see Why don't my table borders print? and Run for the border: using
borders in Word.

Working in a table

You can put almost anything in a table that you can put in normal document text, and
you can format table text the same way you would ordinary text paragraphs. The best
way to do this, of course, is with styles (you may want to define special styles for use in
tables, and Word 2002 even allow you to define special styles for an entire table), but
you can apply font and paragraph formatting the same way you normally do. There are
just a few things that work differently in tables.
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Tabs

When you tab in a table, you go to the next cell (Shift+Tab takes you to the previous
cell). This makes it easy to work in tables because you don'’t have to use the mouse to
move your insertion point. But you can still set tab stops in table cells; the trick is that
you have to use Ctrl+Tab to tab to them. The exception to this rule is the decimal tab.
When you set a decimal tab stop in a cell, the text aligns on it automatically (provided it
is left-aligned or justified to begin with; any other paragraph alignment gives very odd
results).

Selecting text

If you're used to selecting a line of text by clicking to the left of it or a paragraph by
double-clicking to the left of it, you'll find that you can't do this in a table. Whenever you
point to a cell and click, you select the entire cell. But you can still select text by
dragging, and you can select a sentence using Ctrl+click or a paragraph by
triple-clicking in it. And if you normally select text using keyboard shortcuts, these will still
work.

Margins and indents

If you have the horizontal ruler displayed, you will see that it looks very different when
you are working in a table. Instead of seeing indent markers at the page margins, you
will see them at the sides of the space representing the table cell you are currently in.
You can drag these as you normally would to set paragraph indents. You will also see
margin markers on the ruler, representing the edge of each column — more on this later.

S ENCEEFIN - ENECENRERN) - SHKEANRNEN) - ENRFINRIVEN] -

Hanging Inu:lenlzlI

Figure 6: The ruler, when the selection is in a table

Selecting parts of atable

As mentioned earlier, if you point to a cell (the mouse pointer becomes a stubby black
arrow pointing northeast: #) and click, the entire cell is selected.

To select an entire row, point to it as you would a line of text (position the mouse pointer
in the left margin until it is a white arrow pointing northeast) and then click. Or point to
any cell in the row and double-click.

To select a column, hover the mouse over the top of the column until it becomes a
stubby black arrow pointing down. Click to select the column below; drag to select
adjacent columns. You can also select a column by clicking while pressing Alt anywhere
in the column, and in long tables this works much better, because you don't need to be
at the top of the column to select it.

To select an entire table, with the insertion point anywhere in the table, press Alt and
double-click.

You can also use the Select commands on the Table menu to select rows, columns, or
the entire table.

In Word 2002 you can select noncontiguous rows and columns by pressing Ctrl while
selecting rows or columns after the first.

Sizing rows and columns

When you first insert a table, all the columns are the same size, and all the rows are an
“Auto” height that will accommodate the current text size. For example, if you are using
the default Body Text style, which uses the Normal font and has 6 pts Spacing After,
then the table row will be high enough for 10-pt (Word 97 and earlier) or 12-pt (Word
2000/2002) Times New Roman plus 6 pts space following. (It's a good idea to define
specific paragraph styles for use in tables that have borders, with different spacing from
your Normal style; such as 3 point before and after.)
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Because the row height is automatic, it will adjust to fit the amount of text you put into it,
so you will not ordinarily need to change this unless you need empty rows of a fixed
height. But you probably will need to change the width of the columns to accommodate
the text they contain. In Word 2000 and 2002, you can let Word resize the columns for
you (“AutoFit to contents”), but this can be very disconcerting and not necessarily
satisfactory. Furthermore, in Word 2000 and higher, the “Automatically resize to fit
contents” option under Table | Properties | Options slows tables down dramatically,
and it is a good idea to switch it off in all your tables (unfortunately, it is switched on
whenever you create a new table).

Most likely you will want to adjust the column widths manually. There are several ways to
do this.

Sizing columns using the ruler

If you click and drag the area on the ruler that represents the space between cells, you
change the width of one or more of the cells. The way this change is made depends on
how you drag, as follows:

Simple click and drag: The cell to the left of the dragged border is made wider or
narrower, and the other cell widths are not changed (so the overall table width
changes). Since the table isinitialy inserted at margin width, this means that if
you make one of the cells wider, the table will extend beyond the right margin.

Ctrl+click and drag: The cell to the left is sized, and the difference is made up
from the cellsto the right uniformly. That is, if you make the cell to the left
larger, al the cells to the right become proportionately smaller.

Shift+click and drag: The cell to the left is sized, and the differencein sizeis
made up from the cell to theright. That is, if you make the cell to the left larger,
the cell to the right becomes proportionately smaller.

Alt+click and drag: Same as simple click and drag except that the ruler displays
the dimensions of the cells as you drag, permitting finer adjustments.

However, note that the measurements the ruler displays are somewhat misleading, in
that they do not include the “Space between columns” (or cell margins).

For example, if you have a column of width 1" (2.54cm), and if the “Space between
columns” is set to 0.15", or 0.38cm, (the default), then the column width displayed on
the ruler when you hold the Alt key down will be 0.85" (2.16cm).

To find out the “Space between columns” setting using the Table Properties dialog in
Word 2000 and higher, click the Options button on the Table tab, and add the Left and
Right cell margin measurements — although that isn't always accurate, as it only displays
to two decimal places. For instance, if the “Space between columns” is set to 0.15", the
Left and Right cell margin measurements on the Table Properties dialog both display as
0.08" instead of 0.075". A better way of finding out the true measurements is covered at:
How to sidestep the problems of the Word 2000 (and higher) Table Properties
dialog.

Alt+Ctrl+click and drag: Same as Ctrl+click and drag except that the ruler
displays dimensions.

Alt+Shift+click and drag: Same as Shift+click and drag except that the ruler
displays dimensions. (But see aboverider.)

Sizing columns using the cell borders

You can also size the columns by dragging directly on the cell boundaries, and this is
often much easier than using the ruler — partly because the indent markers on the ruler
can make it difficult to get at the margin markers. Most people also find it more intuitive
to drag the columns directly.
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When you hover the mouse pointer over the gridline between two —p——
columns, it will change to a double arrow (pointing right and left) with two :i:
upright parallel lines between it. When it has this appearance, you can

click and drag a column boundary.

You have the same six combinations as above, but, just to be totally confusing, simple
click and drag and Shift+click and drag (and Alt+click and drag and Alt+Shift+click and
drag) are reversed in their functionality.

It is possible that some users actually memorize or remember what these various
combinations do, but | personally just keep trying one after the other (with Undo in
between) until | get the one that does what | want!

Sizing rows
You can also adjust row height either using the vertical ruler or by dragging the cell
boundaries, but only in Page/Print Layout view.

Pressing Ctrl while you drag sets the row to an “Exact”, or fixed, height, so that if there
is too much text in the cell to fit, the surplus text will be hidden (setting exact row heights
is particularly useful for forms). If you don't use the Ctrl key, the row height is set to “At
least” the measurement you chose, so the row will expand in height if needed, to fit the
text in the cell, but will not contract below the minimum height you set.

Pressing Alt while you drag causes the ruler to display dimensions — but prevents you
from setting an Exact height, even with the Ctrl key held down.

Another way to size columns and rows

All versions of Word also have a dialog that allows you to set exact column widths and
minimum or exact row heights. In Word 97 and earlier, this is the Table | Cell Height
and Width dialog, which has Row and Column tabs. Row height is Auto by default but
can also be set to “At least” or “Exactly” a certain amount. By default this measurement
is displayed in points, but you can type in another measurement, followed by the
measurement unit — such as 2" or 5 cm — and Word will convert it to points.

Word 2000 and 2002 have a Table Properties dialog (accessible via the right-click
shortcut menu) that has Table, Row, Column, and Cell tabs. On the Table tab you can
set a “preferred width” for the entire table; this can be set in your default measurement
unit (inches, centimetres, or whatever else you have set on the General tab of Tools |
Options), or you can set the “Measure in” drop-down to “percent”, and set it to any
percentage of the editable page width you wish. If you set it to 100%, it will always
maintain full margin width, no more and no less (for coverage of the nearest equivalent
in Word 97, see: How can | resize a table to fit the page's width?).

On the Row tab of the Table Properties dialog, you can set “Auto,” “At least,” or
“Exactly” heights. On the Column tab you can set a “preferred” width for the current
column, although unfortunately, in Word 2000 and higher, “preferred” width does not
mean actual width, and setting the column width using the dialog usually gives
unexpected results; dragging the columns to set their widths is generally much more
reliable. Fortunately, you can sidestep the unreliability of the Word 2000 and 2002 Table
Properties dialog — see How to sidestep the problems of the Word 2000 (and
higher) Table Properties dialog for details.

Even distribution

An extremely useful option introduced in Word 97 is the “Distribute columns evenly”
command. If you select two or more adjacent columns, right-click, and choose this
option, the total width of the combined columns will be divided equally among them so
that they are the same width.

Adding rows or columns

As you have seen, adding new rows at the end of a table is easy and automatic. But
what if you want to insert rows in the middle? Or what if you have gotten too far along in
your table to start from scratch when you discover you need an additional column? No
problem!

When you select a row or a column, one of the items on the right-click shortcut menu
will be Insert Rows or Insert Columns. Or you can use the context-sensitive Table button

14/01/2002 00:05



Table basics

7 of 12

http://www.mvps.org/word/FA Qs/ThlsFldsFms/TableBasi csContent.htm

(see Figure 4). When you use one of these commands you will insert a row above the
selected one or a column to the left of the selected one.

If you select more than one row or column, Word will insert the number of rows or
columns selected. This is an easy way to insert a lot of rows at once, even at the bottom
of the table. Select the last (still empty) row and choose Insert Rows; select that row and
the new row and press F4 (Repeat) to insert two more rows; select the four rows and
press F4 to insert four new rows; and so on.

In Word 2000 and higher, you can choose whether to insert new rows above or below
the selected row or new columns to the left or right of the selected column. This can be
important when you want to add a row that duplicates the formatting of the row above it
rather than that of the one below (a row above a totals row, for example). On the Table
menu, choose Insert, then Columns to the Left, Columns to the Right, Rows Above, or
Rows Below.

Word 97 and earlier don’t have these commands, but there are workarounds. To add a
new row below an existing one, position the insertion point at the end of the text in the
last cell in the row. Press the Right Arrow key (not Tab). This will position the insertion
point just outside the cell, to the left of the end-of-row marker (which you can see if you
have nonprinting characters displayed). Press Enter, and a new row will be inserted
below the existing one. To insert a new column to the right of the farthest right one,
select the end-of-row markers the same way you would select a column and choose
Insert Columns.

Deleting rows, columns and tables

To delete a row or column, select it, right-click, and choose “Delete rows” or “Delete
columns.” (You can also use Cut.) To delete an entire table, select it and use either Cut
or Table | Delete Table; in Word 2000 and higher, you can also delete a selected table
by pressing Backspace.

Repeating headings

If your table is longer than one page (or continues onto a second page, regardless of
length), you can make your headings automatically repeat on the following page(s). In
Word 97 and earlier, select the row(s) you want to repeat and check “Headings” on the
Table menu. You can repeat more than one row, but they must be the top rows of the
table (you can’t skip any rows).

In Word 2000 and higher, select the desired heading rows and check “Heading rows
repeat” on the Table menu. (There is also a check box on the “Row” tab of the Table
Properties dialog for “Repeat as header at the top of each page.”)

Positioning the table

If your table is less than the full margin width, you may want to indent or center it. The
Row tab of the Table | Cell Height and Width dialog (Word 97 and earlier) and the
Table tab of the Table Properties dialog (Word 2000 and higher) allow you to specify
Left, Center, or Right alignment for the entire table (you can also select the entire table
and use the Left, Center, or Right alignment buttons on the Formatting toolbar). Both
these dialog tabs also allow you to set a specific left indent if you choose.

Having used the Cell Height and Width dialog to set these properties for one table, you
can apply the same properties to any other tables by clicking in them and pressing F4. If
using Word 2000 or higher, see: How to sidestep the problems of the Word 2000
(and higher) Table Properties dialog.

Controlling text flow

You may have already learned to control page breaks in Word by using a combination of
the properties on the Line and Page Breaks tab of Format | Paragraph: “Widow/Orphan
control,” “Keep lines together,” “Keep with next,” and “Page break before.” These work
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a little differently in tables.

“Widow/Orphan control” and “Keep lines together”

These paragraph properties have no effect in a table. There is a check box on the Row
tab of Table | Cell Height and Width or Table Properties that allows you to specify
whether you want to allow a soft page break within a given row (“Allow row to break
across pages”). But if you do allow the row to break, it can break anywhere, even if the
result is to leave one line of text stranded on a page. If you have more than one
paragraph in a cell and would like the row to be able to break between but not within the
paragraphs, you're just out of luck.

“Keep with next”

This command does work, but only between rows. At a minimum, it should be applied to
the header row(s), but it is also very useful for keeping a table together on one page. To
do that, apply it to the text in every row but the last.

If you want to ensure that the first few rows of the table always stay together (so that you
don't, for instance, ever end up with only the table header row at the foot of a page)
apply “Keep with next” to the first two or three rows.

“Page break before”

This one is quite useful. Sometimes you will want to break a table at a certain point. But
if you insert a hard page break (Ctrl+Enter), the result is to split the table, and heading
rows will not repeat. But you can apply the “Page break before” property and you will get
the desired page break and repeating headings. (You can also apply “Keep with next” to
the preceding rows to achieve the same effect.)

Performance issues

See: Maximising the performance of Word tables.

Advanced techniques

All of the above is more than enough to get you started creating basic tables, but Word
allows you to do a lot of other fancy things in tables.

Merging cells

All versions of Word allow you to merge and split cells horizontally. Word 97 and above
also allow you to merge and split cells vertically (and also to adjust cell widths
independently of the column width). To merge cells, select the cells to be merged
(combined), right-click, and choose Merge Cells.

Although in Word 97 and above you can merge cells both horizontally and vertically,
there are limitations. You cannot create an L-shaped cell. If two cells are merged
vertically, then the combined cells cannot be merged horizontally with a single cell but
only with the two adjacent cells. But even in earlier versions, where you cannot merge
cells vertically, you can often create the appearance of merged cells by applying
borders selectively.

In Word 95 and earlier, if you merged two columns, you in effect merged the two cells in
each row of the two columns; in Word 97 and later, unfortunately, you merge the two
entire columns into one big cell, which isn't very helpful! You can get around this,
however, by using the Eraser tool on the Tables and Borders toolbar; if you use it to
erase the border between two columns, the rows remain intact.

I —— = wrZ D>

i iy B - 2 AR T A

Figure 7: The Eraser tool

Merging should be approached cautiously and conservatively. Don’t merge cells
horizontally until you are sure the column widths are final. The reason for this is that
selecting and sizing columns is complicated by merged cells. And don’t merge cells at all
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if you don’t have to. If you can achieve the same effect by omitting borders, do that
instead. Merging cells makes a table more complex and susceptible to corruption, which
is reason enough to avoid it except when absolutely necessary.

Vertical alignment

By default Word places text at the top of a table cell (subject to any “Spacing Before”
you have applied to the paragraph). But sometimes, as in a price list, for example, you
may want to align text at the bottom of the cells. In Word 97, you can choose Top,
Center, or Bottom alignment for all the text in a given cell. This command is on the
right-click shortcut menu when the insertion point is in a given cell. (By default it does not
appear when you have an entire row selected, but you can add it through Customize.) It
also appears on the Tables and Borders toolbar. (Although this feature is very useful, if
you must share documents with users of versions earlier than Word 97, keep in mind
that the alignment will not be retained because it is not supported in previous versions.
In those versions you will need to use Spacing Before or line breaks to position text
other than at the top of a cell.)

Word 2000 and higher have substituted a table alignment palette that displays nine
combinations of vertical and horizontal alignment. If you have defined the horizontal
alignment as part of your style, you will prefer the Word 97—style vertical alignment
menu. You can restore it following the directions in

Text direction

In Word 97 and above, you can rotate text in a table cell 90 degrees right or left. The text
rotation is displayed only in Page/Print Layout view and applies to all the text in the cell.
This is useful when you have long headings for narrow columns. The Text Direction
command is on the right-click shortcut menu when the insertion point is in a cell, as well
as on the Format menu and the Tables and Borders toolbar. (Again, keep in mind that
this feature is not supported in earlier versions.) When text is rotated, the “horizontal”
and “vertical” alignment buttons are rotated accordingly, which can be a little
disconcerting.

E Align Top ]E[ alion Left
[=] Certer vertically =+ ] Center Horizonkally
=] align Battam [T align Right

Figure 8: The Cell Alignment buttons when the selection is in a normal
table cell (left), and in a cell in which the text has been rotated (right)

Cell margins
Space around the text in cells is achieved in several different ways.

In Word 97 and earlier, the left and right cell margins are determined by the “Space
between columns” measurement on the Column tab of Table | Cell Height and Width.

Word 2000 and higher, instead of the “Space between columns” setting, have “Cell
margins” settings that can be established as a default for the entire table or specified for
individual cells. Set default cell margins for the entire table in the “Table Options” dialog
accessed via the Options... button of the Table tab of Table Properties. Set margins
for a specific cell (or selected cells) in the Cell Options dialog accessed via the
Options... button on the Cell tab. You can also still use paragraph indents in cells, but
this should not be necessary except when you want one paragraph indented more than
the rest in a single cell.

The default setting for the “Space between columns” is 0.15", or .38cm, resulting in
0.08" left and right margins being displayed Under Table | Properties | Options in Word
2000 and above, if you use inches (although the true left and right margins are actually
0.075"); or 0.19cm being displayed if you use centimetres. It can be reduced to 0" (no
space between columns) or increased as desired.

This setting applies to all cells in the table, but you can increase “cell padding” using
paragraph indents. You can also reduce the effective cell margin in a given cell by
setting negative paragraph indents; this technique should be used sparingly, however,
since it can have very odd results when the column width is changed.

In Word 97, top and bottom margins (if any) must be created by applying Spacing
Before and/or After to the paragraphs in the cell.
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In Word 2000 and higher, you can set Top and Bottom cell margins by selecting Table |
Properties | Options — but note that any such margins will disappear if a Word 97 user
opens your document.

Word 2000 and above also support something quite different, rather confusingly called
“Spacing between cells”, also accessible via Table | Properties | Options. This setting
seems to be there for the sake of HTML compatibility (it is equivalent to HTML's
“cellspacing”). It creates an ugly effect whereby, instead of adding cell margins, as the
cell margins settings do, it adds white space in the middle of the cell borders, splitting
each border in two:

cellspacing is not really appropriate for

This table has cellspacing applied use in Word.

Figure 9

Graphics in tables

In Word 97 and earlier versions, floating graphics and tables are not compatible. You
can insert pictures as “inline” objects (that is, objects in the text layer) in a table, but you
can’t wrap text around them. Sometimes you can fudge by splitting a cell and putting a
graphic in part of it and text in the other (as has been done with many of the graphics in
this article); but this is not always satisfactory. And you can’t put Word’s drawing objects
(AutoShapes, text boxes) in Word 97 tables at all unless you first convert them to inline
objects (using Copy, then Paste Special as Picture, with the “Float over text” check box
cleared).

In Word 2000 and above, you can insert floating images in table cells. “Floating
images” are those with a wrapping style other than “In line with text” (on the Layout tab
of the Format Picture dialog). Images that have “Behind text” or “In front of text”
wrapping can float freely over the table without being confined within a table cell. An
image with “Square,” “Tight,” “Through” or “Top & bottom” wrapping will be confined to
a cell. If the image is resized to a larger width, the table cell will adjust to accommodate
it.

Having said that, though (and as discussed in the article The draw layer: a
metaphysical space), it is best to use floating graphics only when they are really
needed; and in long documents it is best to avoid them altogether, other than in
Headers, Footers, and on the cover page. And if you do need to use floating graphics in
a table, it is usually best to ensure that their anchors are placed outside the table — see,
for example, the article: Floating objects in Word 2000 table cells are vertically
aligned wrongly.

Nested tables

In Word 2000 and higher versions, you can embed (“nest”) a table within a cell of a
larger table (for an example, imagine the thumbnails of the previous and following
months that might appear in the unused day spaces of a monthly calendar). Nested
tables make a document much more complex, can slow Word documents down
dramatically; and the behavior of the tab key is changed.

The existence of nested tables also complicates working with ordinary tables: because
now you can insert tables within one another, you may see new pasting behavior when
you paste tables. There are specific rules for this behavior, but in general they are pretty
logical, though usually irritating in practice. To summarize, you can paste equal numbers
of cells as cells, but if you try to paste several cells into a single cell, they will be pasted
as a nested table. To prevent this from happening, drag and drop your cells instead of
pasting them; or select Edit | Paste Special as Formatted Text (which is the only
workaround when pasting from Excel into a Word table).

Well-designed web pages would be impossible to create without nested tables, because
the only way to set the width of a web “page” is to put all your text (and any tables within
the text) inside a fixed width table cell; but nested tables are rarely either appropriate or
useful in Word: avoid them when you can.

If you do use nested tables, you will get unpredictable results if the documents are ever
opened in Word 97 or earlier.

“Text-wrapped” tables and frames
You can also turn “text wrapping” on, for Word 2000+ tables, by selecting Table |
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Properties, and setting the “Text Wrapping” to “Around”. This means you can wrap text
around tables, or put two independent tables side by side. Despite appearances, such
tables are not “floating” (that is, they are not in the drawing layer, and they can be seen
in Normal View). In fact, they are in a frame, (although in the case of Word 2002, a
frame with a difference; as you see will see shortly); but the frame borders are hidden
when the document is open in Word 2000 and higher. If you open the same document in
Word 97, the frame borders become visible.

So in case you hadn't already realised this, you can wrap text around Word 97 tables, or
put two independent Word 97 tables side by side, by putting the tables into frames.

It is all too easy to switch a table's “text-wrapping” on inadvertently. When you are
working in a table in Word 2000 and above, you may see a four-headed arrow in a
box at the top left corner of the table (like the one on the left). This “table handle”
appears only in Print Layout view. If you click on it, you can drag the table anywhere
on the page. It then becomes “text-wrapped”. Even if you drag it just ever so slightly,
the table becomes text-wrapped. Needless to say, you must be careful not to drag
the table accidentally when selecting text in the first cell.

The lack of visibility of the frame borders in text-wrapped tables, combined with the ease
with which you can accidentally turn text-wrapping on, makes for a maintenance
nightmare, as it is often difficult to tell whether a table has wrapping switched on or not.

In Word 2000, text-wrapped tables cannot span multiple pages — but can overlap both
the footer area and the non-printing area at the bottom of a page — so you can imagine
the problems this causes people!

In Word 2002, text-wrapped tables can span multiple pages — and they do so by default,
which makes it even more difficult than in Word 2000 to tell whether a given table is
text-wrapped or not! The wrapping of text around Word 2002 tables that span multiple
pages behaves very strangely indeed; for example, If you insert a table in the middle of
text and wrap text around it, as soon as the table breaks to the next page, all the
wrapped text goes with it. Although some of the table stays on the first page, the text
breaks off above it, giving an ugly effect.

Fortunately, you can switch off the ability to span multiple pages by selecting Tools |
Options | Compatibility, and selecting “Don't break wrapped tables across pages.” If
you do that in your templates, your new documents will pick up that setting. Or clearing
the “Move with text” box in the “Table Positioning” dialog under Table Properties also
switches off the ability of a text-wrapped table to span multiple pages.

If you send a Word 2002 document containing a text-wrapped table that spans more
than one page to a Word 2000 or Word 97 user, it will all be on one page when they
open it; it may well overlap the Header and Footer; and some of the table may be off the
page completely.

Text-wrapped tables, like frames and floating objects, also add a memory overhead,
slow your documents down, and increase the risk of document corruption. Using
text-wrapping when it's needed is one thing, but it should never be used if not needed,
and therefore the ease with which wrapping can be accidentally applied is very
unfortunate.

So it is usually much better to do things the old-fashioned way, even in Word 2000 and
above, and insert a “proper” frame (just select the table and click the Insert Frame
button), rather than using the invisible frame that gets inserted when you turn
text-wrapping on. The functionality is identical, but a visible frame makes it far easier to
see what's going on than an invisible one does; and makes for far more maintainable
documents. See also: How can | add the Insert Frame command to the Insert
menu?

Tables and HTML

Most of the changes in table formatting that were introduced in Word 2000 are intended
to make Word more compatible with web documents (so that, for instance, you can
paste web documents into Word without losing any formatting); and also — a much more
minority taste — to make Word more suitable for creating Web pages. Nested tables, for
example, are widely used in HTML, and they persist when documents are round-tripped
(saved back and forth) between document to HTML file format.
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Drawing tables

The Tables and Borders toolbar has a Pencil tool that allows you to draw a table (also
accessible via Table | Draw Table). The premise is that you can easily create
custom-sized cells without the bother of merging or splitting. The reality is that you can
easily get yourself into a whole pile of trouble, especially when you start trying to size the
cells or use the Eraser; and also, if you use this tool you will inevitably make your tables
unnecessarily complex without realising it. It actually takes a great deal of skill not to
make a mess of your tables, if you use the pencil tool. | have had to sort out the mess
made by many users who have used it, and my advice about drawing tables therefore is:
Don't.

Changing your mind

Suppose you start making a simple table using tabs and are pretty far along when you
realize you really need to use a Word table. You could insert a table and drag the bits of
text into the cells, but Word provides an easier way: Convert Text to Table. If you
already have a table set up with tabbed columns, you can select it and choose this
command from the Table menu. In the resulting dialog, make sure that Word is planning
to separate the text at the tabs and that the number of rows and columns it expects to
make is correct. When you press OK, your tabbed table will be converted to a Word
table; Word even does a pretty good job of setting column widths. You'll still have some
formatting to do (beginning with removing the automatic grid border), but it's sure
quicker than starting from scratch!
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